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Before you begin

Before you begin

This Learner Guide is based on the unit of competency BSBTEC301 Design and produce
business documents, Release 1. Your trainer or training organisation must give you
information about this unit of competency as part of your training program. You can
access the unit of competency and assessment requirements at:

www.training.gov.au.

How to work through this Learner Guide

This Learner Guide contains a number of features that will assist you in your learning.
Your trainer will advise which parts of the Learner Guide you need to read, and which
Practice Tasks and Learning Checkpoints you need to complete. The features of this

Learner Guide are detailed in the following table.

Feature of the How you can use each feature
Learner Guide

Learning content ~ Read each topic in this Learner Guide. If you come across content that is
confusing, make a note and discuss it with your trainer. Your trainer is in the
best position to offer assistance. It is very important that you take on some
of the responsibility for the learning you will undertake.

Examples These highlight key learning points and provide realistic examples of
workplace situations.

Practice Tasks Practice Tasks give you the opportunity to put your skills and knowledge
into action. Your trainer will tell you which practice tasks to complete.

Summaries Key learning points are provided at the end of each topic.
Learning There is a Learning Checkpoint at the end of each topic. Your trainer will tell
Checkpoints you which Learning Checkpoints to complete. These checkpoints give you

an opportunity to check your progress and apply the skills and knowledge
you have learnt.

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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BSBTEC301 | Design and produce business documents

Foundation skills

As you complete learning using this guide, you will be developing the foundation skills
relevant for this unit. Foundation skills are the language, literacy and numeracy (LLN)
skills and the employability skills required for participation in modern workplaces and
contemporary life.

The following table provides definitions for each foundation skill.

Foundation skill area Foundation skill description

Reading - Recognises and interprets textual information from a range
of sources to determine and adhere to requirements

Writing - Develops documents using required format, accurate
spelling and grammar and terminology specific to
requirements

Organises content to support purposes and audience of
material, using clear and logical language

Self-management = Recognises and follows explicit and implicit protocols and
meets expectations associated with own role

viii Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting



What do you already know?

Before you begin

Use the following table to identify what you may already know. This may assist you to

work out what to focus on in your learning,.

Topic Key outcome Rate your confidence
in each section

Topic 1: Select and prepare 1A

resources

1B

1C

1C

Topic 2: Design the 2A

document

2B

2C

Select and use technology and
software applications

Select layout and style of
publication

Ensure consistency of design with
organisational requirements

Clarify format and style

Identify, open and create files

Design the document and ensure
efficient entry of information

Use a range of functions to design
the document

U Confident
1 Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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Topic Key outcome Rate your confidence
in each section

Topic 3: Produce the 3A Complete document production U Confident
document according to organisational

: U Basic understanding
requirements

U Not confident

3B Check documents for style and U Confident

layout U Basic understanding

U Not confident

3C Store and save documents U Confident
[ Basic understanding
U Not confident

3C Overcome basic difficulties with W Confident

document design and production O Basic understanding

U Not confident

Topic 4: Finalise the 4A  Proofread the document prior to W Confident

document final output U Basic understanding

L Not confident
4B Make modifications 4 Confident
U Basic understanding

U Not confident

4C Name and store the document, and [ Confident
exit the application O Basic understanding

U Not confident

4D Present the document U Confident

U Basic understanding
U Not confident

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting



Topic 1| Select and prepare resources

1A
1B
1C
1D

Select and use technology and software applications

Select layout and style of publication

Ensure consistency of design with organisational requirements

Clarify format and style

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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1 Select and use technology and software
applications

All organisations design and produce business documents to communicate and
organise information.

These documents can be for internal or external clients and contain information about
all aspects of the business.

You need to choose the best technology and software applications for each job. Always
start with the outcome. What do you want to produce? The type of technology you use
should always depend on the types of documents you want to produce. For example, you
would use presentation software to develop a slide show presentation. It would not be
appropriate to complete this task in Word.

A single job can sometimes require a selection of business software and equipment. For
example, you might be asked to design a slide show presentation for your manager and
supply a hard copy of the speech. To achieve this you would need to use presentation and
word-processing software. You would also need to use a printer to print out the speech.

You need to be able to identify the different types of business documents in your
organisation, which may include the following.

Newsletter \

A periodical publication. It may contain photographs and text. It can be used
to make an announcement, such as the appointment of a new staff member;
and to circulate news, such as an article on current research the organisation
is doing. Email newsletters, often referred to as e-news, are an excellent way
to communicate with internal and external clients. They are also a good way to
save on postage and paper, though you must ensure that you comply with the
Australian regulations for sending bulk emails.

- )

Client database \

Stores information about customers in a structured way. It usually has the
names and addresses of customers and details of any products and services
they have purchased. A database uses fields, records and tables to organise
this information. It allows an organisation to store, modify and extract
information (such as a telephone number) about one client or many. A client
database is a powerful tool and it might be your responsibility to design and
use one.

N /
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Proposal I

Outlines how an organisation can produce a product or service for another
organisation. For example, if an organisation wants to supply a cleaning service,
it would outline the details of its service in a proposal and submit it to the
potential client. A proposal can also be used to apply for a government grant.

In this case, it would contain information about why the grant is needed, what
purpose it will serve and how much money is needed. A proposal is always a
written offer to accomplish an objective in a particular way for financial gain.

Report I

Describes the findings of an individual or group. For example, a research officer
has to write reports that describe what their research has discovered. A report
can be used to communicate information to internal and external clients.
Reports are one of the most common types of business documents. Whatever
your role, you will most likely have to write or read an organisational report.

Accounts statement \

Contains information about the specific assets, liabilities and fund balances
of an organisation. It helps an organisation understand how well it is doing
financially. Accounts statements are often used to make decisions. For
example, a financial statement that details the profitability of a product would
be used to make a decision about whether to continue with the production of
that product. Accounts statements are needed for taxation purposes. When
the taxation department audits an organisation, it needs to produce all of its
accounts statements.

v

Project review I

Describes the progress of a project. A project can run for 12 months or longer
and it needs to be reviewed at certain intervals to make sure that it is on
budget and on time. Project reviews are usually written by the project manager
and presented to management. They are then used as a basis for decisions
about the project. For example, management might decide to hire more people
if the review shows that the project has met with an unexpected workload and
is running behind time.

\_ /
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Web page \

A page on the World Wide Web (internet). It is displayed using a web browser
and may contain text, illustrations, motion graphics, audio and interactive
media. It may also contain hypertext links to allow navigation from one page,
or section, to another. Web pages are used extensively by organisations to
advertise products and/or services. They are also used to help clients make an
online purchase. This is called e-commerce.

\_ /

Use business technology

It is important to know what is available in your workplace and to use it appropriately.
You might need to make choices about business equipment and software.

The most common piece of equipment in the office is the computer, which is used to
input, process and output business information.

You might also have to use printers, scanners and photocopiers. Descriptions of the
functions of each of these types of business equipment are included here.

Keyboard

» To use a keyboard efficiently you need to be confident and streamline your actions.
Practice makes perfect. There are many online typing lessons available. Use a search
engine to find a lesson that suits you.

» Speed and accuracy can be improved if you are in a comfortable position. With less
discomfort and fatigue you will be more alert and have better concentration and
comprehension.

* If you need to enter a lot of numerical data, activate the NumLock function on your
keyboard by pressing the NumLock key. You will then be able to use the numerical keypad
to the right of your keyboard.

» Another way to streamline your typing is to use the shortcuts on your keyboard. For
example, if you press Alt+Tab you can switch between two open programs on your
computer. This saves time locating the other program. Other shortcuts allow you to open
your Start menu, quit a program, operate a program and cut, copy and paste content.
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Mouse

* A mouse can be used to control the cursor on your computer. It can be customised to suit
your individual needs.

» If you customise the mouse settings, you will be able to choose a right-handed or left-
handed mouse button configuration, adjust the double-click speed and turn on the
ClickLock feature, which allows you to highlight or drag without holding down the mouse
button.

» Other mouse options allow you to change the pointer scheme (how it looks), adjust the
pointer speed and adjust the acceleration rate. You can also show pointer trails, hide the
pointer while typing and show the location of the pointer.

» As with so many other features of your computer, just because you can do something does
not mean that you necessarily should.

Printer

» A printer is a device that produces a paper copy of the information displayed on the
monitor of your computer. There are many different printers available. The main differences
are the speed at which material is printed, quality of the print, options available and cost.

* Your organisation may have several different printers and you will have to make a decision
about which one is most appropriate for your use. For example, does your document need
to be printed in colour, or black and white? Do you need to print on one side or both sides
of the paper?

 Printing usually involves a number of decisions. Before you press the ‘print’ button, you
need to consider the specific requirements of your task, the software application you are
using and the capabilities of your printer. You may have various options for printing. For
example, in Microsoft Project you can choose to print a project overview, a summary of
tasks or just the milestone tasks. If you are printing a spreadsheet, you may wish to print it
at actual size, or scale it to fit on one page.

Scanner

» A scanner is a device that produces a digital version of a hard-copy document. For
example, if you scan the hard-copy version of a report into a computer you can send the
information electronically or make alterations before reprinting.

» A scanner can be a useful piece of equipment if you are producing a newsletter, catalogue
or any other document containing photographs, illustrations, maps or handwritten
material. It can copy a selected image into a graphic file on a computer. This can then be
imported into the document you are working on. The image can be resized, if you need to
make it smaller, or cropped if you only want to keep part of the image.

* There are two primary types of scanner:
 aflatbed scanner that is connected to your computer but stands alone
* ascanner that is incorporated into a photocopier.

» A flatbed scanner can scan most images as it caters for many different sizes, from a
photograph to a map. The other type of scanner is not as flexible and is most suited to
single-sheet documents up to A4 size.
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Photocopier

» Photocopying is a process that makes a paper copy of a document, or any other visual
image, quickly and cheaply. If an organisation needs multiple copies of a document, a
photocopier is the most suitable equipment to use. Documents such as price lists, product
information and internal reports often need to be copied and sent to customers or stored
for employee use. Because people use photocopiers so often, it has prevented most
offices from becoming totally paper free. Try to use the photocopier in your organisation
wisely and save paper.

Business software

Wherever you work, you will have to use business software, which is made up of
a series of instructions that make a computer do tasks. Software is also called a
program.

There are two major categories of software: system and application. System software
supports the production or execution of an application program but is not specific to any
particular application. An example of system software is the Windows operating system.
Application software performs a more useful function, as it processes or manipulates
data. Examples of application software are Microsoft Word, Access and Excel.

Here are the main types of application software that are used in a business environment.

Business software applications

Word- » Word-processing software is used to create, store and print documents.
processing You can type and edit text, and insert graphics, to create documents that
software can be easily saved. Any document that involves written information is

usually created using word-processing software.

e The software can save documents in multiple output formats depending
on user requirements. You could use portable document format (PDF)
or a web-based format, such as hypertext mark-up language (HTML).

e A commonly used word-processing software is Microsoft Word.

Spreadsheet * In accounting, a spreadsheet is a large sheet of paper that displays the

software financial position of a company. It spreads, or shows, all of the information
(such as costs, income and taxes) on a single sheet of paper and organises
information into columns and rows. Spreadsheet software records and
processes information in the same structure. For example, a spreadsheet
showing accounting transactions could group data in areas such as
accounts payable, accounts receivable and payroll. The data can then be
manipulated by a formula to give a total or sum.

e Spreadsheets present a lot of information in an easy-to-read format and
can help decision-makers see the big picture of an organisation.

* A commonly used spreadsheet software is Microsoft Excel.
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Business software applications

Database
software

Presentation
software

Accounting
software

Database software organises information in such a way that you can
quickly select the desired piece of data.

Data is organised by fields, records and tables.
A field is a single piece of information; for example, a client's last name.

A record is one complete set of fields; for example, a client's full name and
address.

A table is a collection of records; for example, every client’s name and
address.

A database allows an organisation to store, modify and extract information
about customers and products. For example, you can extract information
about all clients who live in a certain area from a database of client details.

A commonly used database software is Microsoft Access.

Presentation software is often used by presenters to give a clear visual
display of the points covered in a talk. It can also be used to create slide
shows or multimedia presentations.

It usually includes three major functions:

- The slide show system to display content

- An editing tool that allows text to be moved around from slide to slide
- A graphics system for quickly drawing charts and graphs.

A commonly used presentation software is Microsoft PowerPoint.

There are many commercial accounting software packages available.
These enable financial records and reports to be recorded and generated
electronically. Compared with a manual accounting system, commercial
accounting software enables much more extensive and reliable record
keeping and a vast array of reporting options to be generated readily.

Some organisations use a commercially available accounting package
such as Mind Your Own Business (MYOB) or QuickBooks, which they
tailor to suit their own organisational requirements. Some organisations
use accounting software specifically designed for use in the particular
organisation type, such as schools or hospitals.
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Practice Task 1

Imagine that you have to produce the documents in this table. Fill in the type of business
equipment and/or software you would need for each one.

Type of document Business equipment/software

A hard-copy version of a report containing
text and financial statements. Some of the
information for the report is only available in
hard copy and some alterations still need to
be made.

An e-newsletter, including text and
photographs, which also includes statistical
information extracted from client details

A proposal to another organisation, to be
presented in the boardroom by your manager
to the organisation’s owner. Your manager
requires some notes in hard copy.

A database of client information

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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1 B Select layout and style of publication

The layout and style of a publication is critical to its impact on the reader,
just as the contents are.

If a business document is difficult to read because of poor design features, its contents
are less likely to make any impact on the reader. The reader may be distracted by poor
layout instead of concentrating on understanding the content.

Layout and styles

The layout and style of a publication will depend on what the organisational
requirements are for the particular document type. Any document you create must fit
the specifications of your organisation. It is a good idea to find a sample before you start.
By looking at the sample and asking about the specifications, you should be able to work
out exactly what layout is needed.

For example, your organisation might have a preferred layout for business reports, which
requires using the following guidelines for structure and format.

Structure e Begin with an outline.
¢ Follow this with bullet points covering the major issues.
¢ End with a report summary.

Format ¢ Use a particular font type and size (such as Times New Roman 12 pt).
e Use a certain colour and style for headings (such as black and bold).
¢ Make sure paragraphs are properly spaced so the report is easy to read.

Meeting minutes

The full block style of minutes of meetings is shown below.

Information contained in minutes

» Type of meeting, place, date and time

* Name of the chairperson and names of persons present (Chairperson first, then in
alphabetical order)

e Apologies

» Confirmation of minutes of the previous meeting

* Matters arising from the minutes of the previous meeting (if any)

« Other matters such as reports, correspondence, business discussion

* The time the meeting was closed

» Space for the chairperson to sign and date (to be completed during the next meeting)

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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-

Preparing minutes

Minutes of the Eighth Annual General Meeting of the North Sydney Squash Club

Present

Cameron Strong (Chairperson)
Diane Crookes

Harold Dentener

Barbara Barry (Secretary)

Apologies
Apologies were received from Carol Burnett.
Minutes

Minutes of the seventh Annual General Meeting were read, approved and signed
as a true and correct record.

Election of officers

It was resolved that the present officers be re-elected for a further season. Moved
by Harold Dentener, seconded by Diane Crookes.

Subscriptions

It was resolved that subscriptions be increased by 10 per cent for the new season.
Moved by Barbara Barry, seconded by Harold Dentener.

Tournament entries

It was agreed that tournament entries are very high and it was suggested that
Cameron Strong raise this point at the next regional meeting.

The meeting concluded at 8.30 pm.

Chairperson: Cameron Strong Date: 30 October 2020

J

Temp

lates

There are many templates for business forms which can be downloaded from Microsoft
Office Online.

Visit Microsoft’s website and select Templates. There you can download a variety of pro-

forma documents such as agendas, brochures, business cards and flyers. Alternatively, in
Microsoft Word, click on the File tab, select New and click through the selected searches
to find the template you want. Select the template and click Create on the right-hand

side to download.

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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Identify organisational requirements

Most organisations have requirements for the layout and style of documents. Meeting
these requirements helps achieve a professional quality and ensures all documents are
produced in a consistent format. You should identify these requirements before you
design your document.

Information often has to follow a certain format to be accepted. For example, postcodes
must have four numbers, customer IDs must have the right combination of numbers and
letters, and customer balances must have a currency format.

The layout and style requirements of a publication may also be influenced by factors such
as budget restrictions. For example, a fixed budget may mean that annual reports cannot
be printed in colour or presented in binders. Another example would be a company
preparing a promotional brochure using plain paper rather than heavy-duty card or

glossy paper.

Organisational quality assurance and/or procedures manuals also dictate the layout
and style applicable to business documents. For example, there may be documented
procedures in your organisation that are about having a consistent layout of agendas,
business letters, minutes of meetings or annual reports and using a specific style of
presentation.

Report specifications
This report has been developed to fit certain design specifications.

Report on paper usage
Overview

Paper usage has reached an all-time high with twice as much paper being
ordered per month as was ordered at the same time last year. This report outlines
strategies to reduce paper wastage.

Main points
¢ All printers purchased are to have double-sided printing capacity.

¢ Printing from all terminals is to be tracked by the printer and each department
made aware of its monthly paper usage.

» Budget for paper consumption is to be reduced.
e Staff are to communicate using email rather than written memos.
Summary

Our goal is, with the assistance of these changes, to bring about a 25-per-cent
reduction in paper usage. Up-to-date figures and costs for paper consumption will
be released in one month.

1
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Practice Task 2

Look at the report in the previous example and answer the following questions.

Question 1

The main sections in the report are easy to read. How is this achieved?

Question 2

The report has three sections. What are they?

Question 3

The overview of this report has to stand out from other sections. How is this achieved?

Question 4

What do you observe about the layout of the document?

12 Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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1 Ensure consistency of design with
organisational requirements

Inputting information into the computer is just the beginning. Once you have
entered the relevant data, you must organise the content and structure.

This is called designing a document and each task will be different. It all depends on the
type of document you are working on and the requirements of your workplace and the
intended audience.

Consistent design ensures that the layout of the content flows smoothly to help
users navigate and understand, and will help you create a final presentation that
looks professional. Use consistent design techniques in the following features of your
document.

Headings

Use a font and font size for a major heading so it will inform the reader of the focus
of the page/document. Headings should be large enough for easy reading and can
be centred, left aligned or right aligned. There is usually only one major heading but
sometimes there is a major subheading also (which should be in a smaller font size).
Subheadings are a transition from the major heading to body text and make it easy
for readers to locate information. Subheadings are usually in bold and in a smaller
font size than the major heading/s.

Lists

Numbered and bulleted lists can have less spacing between items and more above
and below the list.

Borders and lines

Borders and lines can be added to documents. Again, spacing must be consistent -
if you insert a 12 pt space (or one Enter) before one line, then the next line must have
the same amount of spacing used.

Spacing

Variations can occur; for example, the spacing between a bulleted list could be
reduced to 3 pt or 4 pt if it is necessary to fit text on a page, or spacing after
subheadings could be reduced.

13
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Punctuation and capitalisation

It is important that punctuation is consistent throughout, including such things as the
use of single or double quotation marks, and whether the last two items in a list are
separated by a comma. Capitalisation in headings must be consistent; for example,

in this unit only the first letter of headings are capitalised. This style is called minimal
capitalisation.

Paragraphs and alignment

Paragraphs help break up the text and keep ideas organised. Some paragraphs are
typed so they start from the left margin of the page. This style of paragraph is called
left aligned. Others are indented so each new paragraph starts a few spaces in from
the left margin. Like headings, paragraphs may be aligned to the left or right, or
centred. They may also be justified, which means that the text and often the spaces
between words are stretched to create a consistently shaped block of text.

Margins, indentations, headers and footers

Typically, margins are set up to be the same for left and right, and for top and
bottom. If indented paragraphs are used, set these up to be consistent. Use the
header and footer features of Microsoft programs to ensure consistency of headers
and footers throughout your document.

Basic design principles

Following some basic design principles will ensure your document is well presented and
easy to read.

Contrast

Contrasting elements, such as changes in font, colour and layout, can engage
readers and draw their attention to important features in the document. Look at this
learner guide and notice how the heading size changes and the font is different for
some features. When contrasting features are used repeatedly and consistently, it
helps the reader recognise similar parts of the document and makes it easier to read.

Repetition

Repetition refers to repeated visual elements, such as use of colour, shape, columns,
headers and callout boxes. Repeated design elements help readers understand the
structure of the document.
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Alignment

Alignment refers to how the text, images, headings et cetera are positioned in the
document. For example, texts can be left or right justified, or centred. Text columns,
tables or pictures can line up evenly. Captions can be anchored next to images.
These factors ensure the proper flow of information and make the document easier
to read.

Proximity

Proximity refers to the placement of elements such as text, images and tables
together so that it makes sense and allows the document to flow better. Sometimes
you may have to place detailed tables or information in an appendix, but the
reference to the appendix should be close to the relevant information in the
document.

Here are some design tips that might be helpful when preparing your document.

Design tips

 Distinguish primary (important) from secondary (additional) ideas.

» Set off examples from the text.

e Draw attention to headings.

» Draw attention to certain parts of a document,

» Make information easy to find.

» Arrange every element to lead the eye progressively from one part to the next.
» Provide visual relief by including artwork and white space.

» Use a consistent style throughout the document.

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting 15
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Practice Task 3

Question 1

This document has numerous design and layout inconsistencies. Highlight each inconsistency
and explain why you think it is an inconsistency.

Cardiopulmonary resuscitation (CPR)
If someone is unconscious, check for signs of breathing.
Dial 000 for an ambulance.
If person is not breathing:
Turn them on their back
Tilt their head and lift their jaw

» Ensure the airway is open.

* Pinch nose closed.

» Take a deep breath and seal your lips around the person’s mouth.
* Give two breaths
» See if the chest rises.
* Remove your mouth and allow the chest to fall.

o} Start chest compressions
Position one hand on the centre of the chest
Grasp wrist with other hand
Compress breastbone 4 to 5 cm or one third the depth of the chest
> Continue with 2 breaths to 30 compressions
> Rate of compressions is 100 per minute or almost 2 per second

dO nOT sTOP uNLESS:
Help arrives

Person breathes normally
You're totally exhausted.
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1 D Clarify format and style

Consistency in the format and style of business documents is always important.

Looking at an existing sample of a document is a good place to start. Once you have
developed a plan, try to clarify it with the end user or someone who can represent them.
You need to be clear about the purpose of the document and the audience you are
targeting.

Purpose and audience

Before designing a document, you need to think about who you are
communicating with and what information, or message, you are trying to convey.

You should always clarify the purpose of the document. What type of document is it?
What is it meant to do? It may help to put these thoughts in writing; for example, "This
document is a presentation to outline my work progress.’ A single sentence stating the
purpose of your document can help to focus your writing.

You also need to clarify the intended audience of the document. Is it for a large or small
group? Is it for your colleagues or external clients? Knowing and understanding your
audience will influence the way you design the document. It should also influence

the way you portray your intended message. You need to think about what you want
your audience to know, what your audience needs to know, and what your audience
already knows.

A lot of time can be wasted by not clarifying the format and style of the proposed
document with the person requesting the publication. It may be that they need guidance
on the principles of good format and design. Show them samples of other publications
and explain the options available for different styles. Ask them questions about what they
have in mind and make constructive suggestions for improvements. Be certain to clarify
exactly what you have discussed and agreed on.
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Report format and style

The following example shows the same report designed in two different ways.

Report on paper usage
Overview

Paper usage has reached an all-
time high with twice as much paper
being ordered per month as was
ordered last year. This report outlines
strategies to reduce paper wastage.

Main points

¢ All printers purchased to have
double-sided printing capacity.

e All printing to be tracked by the
printer and each department made
aware of its monthly paper usage.

¢ Budget for paper consumption to
be reduced.

» Staff to communicate using emails
rather than written memos.

Summary

It is hoped that these changes will
bring about a 25 per cent reduction in
paper usage. Up-to-date figures and
costs for paper consumption will be
released in one month.

Report on paper usage
Overview

Paper usage has reached an all-
time high with twice as much paper
being ordered per month as was
ordered last year. This report outlines
strategies to reduce paper wastage.

Main points

All printers purchased to have double-
sided printing capacity.

All printing to be tracked by the
printer and each department made
aware of its monthly paper usage.

Budget for paper consumption to be
reduced.

Staff to communicate using emails
rather than written memos.

Summary

It is hoped that these changes will
bring about a 25 per cent reduction in
paper usage. Up-to-date figures and
costs for paper consumption will be
released in one month.

Practice Task 4

Read the two reports from the previous example and answer the following questions.

Question 1

Which report is easier to read?
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Question 2

Describe the design principles used in the first report.

Question 3

Describe any design problems you can identify in the second report.

Summary

« Business documents communicate and organise information.

«  Select appropriate technology and software applications to produce the business
documents your organisation requires.

+ 'The layout and style of a document is critical to its overall appearance and
clarity. It has to be prepared in line with organisational requirements and
audience needs.

+ 'The document design must be consistent with organisational or client
requirements and follow basic design principles.

«  Before preparing a document, clarify the format and style with the person
requesting its publication.
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Learning Checkpoint 1
Select and prepare resources

Part A

1. Choose four types of business documents from the seven listed in this topic. Write one
paragraph about each document including its purpose.
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2. Four pieces of business equipment are available in an organisation:

Computer
Scanner
Photocopier
Printer.

Decide which piece(s) of equipment to use in each situation in the following table.

A hard-copy report needs to be reproduced 10 times.

A hard-copy photograph needs to be put into an
e-newsletter.

A proposal needs to be written and 50 copies made.

A hard-copy accounts statement needs to be updated
and emailed to an accountant.

Part B

Read the case study, then answer the questions that follow.

Case study

Moira works as an executive assistant. Part of her role is to prepare documents for her manager,
who is going to make a presentation to all staff next week. He has asked Moira to develop the
presentation, including the presenter notes.

Moira found the organisation's style guide for developing presentations and designed the
information accordingly. She applied design principles consistently throughout the document. She
prepared presenter notes and made a hard copy. The presentation included some photographs
that Moira had to scan before she could include them on slides.

1. List the types of business equipment that Moira would have used to design the presentation.
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List the types of business software that Moira would have used to design the presentation.

How did Moira make sure that the style of her presentation met with the requirements of her
organisation and that she applied design principles consistently throughout the document?

Explain why multiple business technologies are usually needed to develop a business
document,

23
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Part C

Read the case study, then answer the questions that follow.

Case study

Eleni works as an office administrator in a large organisation. One of her duties is to design
presentations. These are sometimes for the board of directors and sometimes for her colleagues.

One day Eleni was asked to put together some information describing the progress of a new
project. Eleni assumed this information was for her colleagues. She wrote a detailed report
outlining the project’s progression.

When the time came for the document to be used, Eleni discovered that it was for the board of
directors, who had little knowledge of the new project! They prefer visual presentations rather than
text-based documents, as they do not have the time to read them. Eleni had no time to change the
document,

1. Eleni did not design the document for the intended audience. What might the consequences be?

2. Eleni should have clarified two points before beginning her task. What are the two points?
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3. Explain why it is important to clarify the purpose and audience of a document before design
begins.
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2A Identify, open and create files
2B Design the document and ensure efficient entry of information
2C Use a range of functions to design the document

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting

27



28

BSBTEC301 | Design and produce business documents

2 A Identify, open and create files

A file can contain any kind of information; for example, board meeting minutes,
a report or accounts statements. You can save files as different file types
depending on the software you use.

When producing a business document, you may need to access other documents that
contain information you need. To get started, identify all the files and resources you
need. Examples are other reports, data from spreadsheets and images. If you do not know
where to find these, ask your manager or colleagues for the file location or ask that they
email these to you.

You could then create a new folder for these files so you have everything in one location
while you are working on your business document. To create a new folder, use File
Explorer to navigate to the place you want to save the folder, use your keyboard to create
a new folder by typing Ctrl+N and then name your new folder.

Open files

Copy the resources you need into a folder and open them by double-clicking on the file
name. If the software application related to that file is not already open, it will launch as
your computer opens the file.

Create files

To create a new file for your business document, open the software you want to create
the document in and use Ctrl+N to create a new document. You may be prompted to
choose a template for that new file. You should save the file immediately, giving it an
appropriate name.

If you are naming a new file you must consider the names of files that already exist. This
is the only way to ensure consistency and prevent duplication. Your organisation may
have a file classification system that sorts files by codes or identification (ID) numbers.
If this is the case, you may need to generate a new code or ID number for the new file.
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Practice Task 5

Tahli has been set a task to produce a price list of all the company’s current products. His manager
tells him he can find everything he needs in the product folder.

Question 1

What type of business product is Tahli producing?

Question 2

Tahli opens the product folder and finds the following files. Which files should Tahli select for
the task?

e Current-products.xlsx

e Product-pricing.xlsx

* Company-logo.jpg

* Product-manufacturing-costs.xslx
e Price-list-template.docx

* 2018-price-list.pdf

* Production-timelines.xIsx

e Product-showcase.ppt
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Question 3

Which programs can open the following file types?
+ .docx

e xlsx
o .pdf
* .ppt

Question 4

What program should Tahli use to create the price list?

Question 5

What should Tahli name the document he is creating?
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2 Design the document and ensure efficient
entry of information

Efficient entry of information helps streamline the process of document
preparation.

If you have all the information you need before starting, you can sort it into a logical
sequence.

By taking some time to plan and design your document, you can ensure that information
can be entered efficiently and that you do not waste time later moving content around
and restructuring your document.

Use design tools to help you enter information efficiently

In Microsoft Office, you can use themes, templates and styles to quickly set up
a document that will allow for efficient entry of information.

Your organisation may already have preset themes, styles and templates to use so you
should always refer to your style guide before designing your document. However, it is
simple to choose and modify themes, templates and styles to suit your task.

Themes

You can change the document theme that is applied by default in Office programs by
selecting another predefined document theme or a custom document theme. Document
themes that you apply immediately affect the styles that you can use in your document.
A style is a combination of formatting characteristics (such as font, font size and
indentation) that you name and store as a set. When you apply a style, all the formatting
instructions in that style are applied at one time.
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Apply a document theme
To apply a predefined theme, take the following steps.

1. In Word or Excel: on the Design tab, in the Document Formatting group, choose

Themes. j

Themes

2. In PowerPoint: on the Design tab, in the Themes group, click the document theme
that you want, or click More to see all available document themes.

n o s ’ MACTAS AN E GEABOW e e acmad
2 e S | | G
In PowerPoint, you can apply a document theme to all slides, to selected slides

only or to the master slide. Right-click the document theme, and then click the
option that you want.

3. To apply a predefined document theme, click the document theme that you want
to use under Office.

4, To apply a custom document theme, click the document theme that you want to
use under Custom.

Note: Custom is available only if you created one or more custom document themes.
For more information about creating custom document themes use the help feature
on the Microsoft program you are using.

5. If a document theme that you want to use is not listed, click Browse for Themes to
find it on your computer or a network location.

6. To search for other document themes on Office Online, click Search Office Online.

N

/
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Customise a document theme

To customise a document theme, you start by changing the colours, fonts or line and

fill effects. Changes that you make to one or more of these components immediately
affect the styles that you have applied in the active document. If you want to apply these
changes to new documents, you can save them as a custom document theme.

~

Save a document theme

Any changes that you make to the colours, fonts or line and fill effects of a document
theme can be saved as a custom document theme that you can apply to other

documents,

1. In Word or Excel: on the Design tab, o TTTLE Title
in the Themes group, click Themes, === el vt e
then Save Current Theme. Thev’“es‘ e o

Office
Aa ’] Aa m Aa 33% Aoi|
Office | Facet Integral Ion
|Aa Aa Aa Aa |
;--II'.II. :I---I i aEmmem | EEmRe.
Ion Board...  Organic Retrospect Slice
Aa 1
Wisp

Reset to Theme from Template

1

= Browsefor Themes...

LFB Save Current Theme...

In PowerPoint: on the Design tab, in the Themes group, click More |/ .

'hin Prmentation

NS e |

-------
-----

o | R

% Grmene for IH
u

" Soen Cumant Thame

2. Click Save Current Theme.

3. In the File Name box, type an appropriate name for the theme. A custom
document theme is saved in the Document Themes folder and is automatically

added to the list of custom themes.

N /
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Templates and styles

When you are creating a document that uses consistent headings and text
styles, the most efficient way to format it is to create styles. A template has
preset styles.

A style is a set of text formatting conditions that are applied
to characters or to a paragraph. The advantage of using style

Clear AN

sheets is that when you change the style, Word automatically

I Normal

changes all characters or paragraphs in the document that use No Spacing 1
that StYIG. eading ©
By creating templates with well-organised, sensibly named Title ;

styles, you will increase your document production efficiency subtit =
as you will be able to format text in just one or two steps rather it oo

Emphash a

than having to take several steps each time.

Creating styles for frequently used documents such as letters, suong
flyers and brochures will save you time because you can apply
the style to each paragraph in the document.

To identify a paragraph’s style, select the paragraph by clicking ‘ :

anywhere inside it. Select the Home tab and click on the fo0k Mo .
small diagonal arrow to the right of the Styles box. The Styles : ""':‘:’e”m 3
window will now appear. Ovsatie Leked St

Each style is identified as either a paragraph style (marked by
the symbol ) or character style (marked by the symbol @).
Experiment with using different styles, and changing and modifying styles.

You can move the styles box to different sides of the page you are working on by dragging
it with your cursor.

To create a new style, select the text you want to create as a new style. Select the drop-
down arrow at the edge of the style box and select Create a Style. You can also select
the New Style button | .| at the bottom of the Styles box. Give the style a name and
click OK.

This style will then appear in the Styles gallery.

To modify a style, click on the drop-down menu next to the style you wish to modify in
the Styles box. Click Modify Style. You can then change the font size and type and access
extra formatting options by selecting the Format drop-down menu.

The changes you make will apply to all text that has that style applied to it.
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Practice Task 6

Set aside at least 30 minutes to use the features described in this section on a business document
of your choice. Select your document and apply a document theme either using a predefined or
custom document theme. You can use Microsoft Word, Excel or PowerPoint to do this. Practise
changing the colours, fonts, and line and fill effects that are used in the original document using the

instructions in this section.
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2C Use a range of functions to design the
document

Once you have designed a document, it needs to be formatted.

Organising the content and structure of your document is the first step. For most
documents, you will use a word-processing application, such as Microsoft Word, for this
task. Within this program there is a range of functions to help make your work more
consistent. In this section you will look at the software functions for:

 formatting text

. formatting styles

« headers and footers

. formatting tables

« merging and comparing documents, and tracking changes

« spellchecking and editing.

Format text

Formatting the text of a business document improves the overall appearance
and presentation of the information.

Although many software programs have formatting options, this topic will only describe
the functions of Microsoft Word.

Before going any further, you need to find, or create, a Word document you can work on.
Make sure it has at least eight paragraphs and is at least three pages long. It can be on
any topic. It might even be an existing document from your workplace. You will use this
document to complete some of the tasks. You will also be asked to work on it as you read
through the topic.

If you do not have a document you can access, go to your local newspaper’s website and
copy a section of a news story to work on.

The Home tab

The following functions are found on the Home tab.

The Font group allows you to change the font and size of selected

Times NewRo - 12 ~ text and numbers.

The Bold, Italic and Underline functions allow you to perform these
actions on selected text.

aky The Highlight and Font Colour functions allow you to highlight text
L T to stand out from the surrounding text or format selected text with a
chosen colour.
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The Home tab: paragraph group

The Paragraph group enables you to select the following functions.

The Align Left, Center, Align Right and Justify functions allow you to
perform these actions on selected text.

|
[l
1l
Il

o The Numbering and Bullets functions allow you to add numbers or
R bullets to selected paragraphs.

(A
-

4
11

R The Decrease and Increase Indent functions allow you to indent the
== selected paragraph to the previous or next tab stop.

- The Outside Borders function adds or removes a border around the
= selected text.

Formatting styles

When using Microsoft programs, the word ‘style’ refers to a set of formatting
characteristics that you can apply to text, tables and lists in your document to quickly

change their appearance. When you apply a style, you apply a whole group of formats in
one simple task.

There are three types of styles you can create and apply, as shown below.

Paragraph style

A paragraph style controls all aspects of a paragraph’s appearance, such as
text alignment, tab stops, line spacing and borders; it can also include character
formatting.

Character style

A character style controls aspects of selected text characters in a paragraph, such
as the font and size of text, and bold and italic formats.

Table style

A table style provides a consistent look to borders, shading, alignment and fonts in
tables.
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Change a style

The Styles group enables you to select or change the styles in an existing
document.

A style is created by selecting a number of different formatting attributes and naming the
style. For example, you might:
select Arial for a font
« choose size 14 (pt) for a font size
make the style right-aligned
colour the text green
name the style ‘Heading A’

Your style, Heading A, can then be applied to any of the headings within your document
without having to redo all the formatting selections.

Styles allow you to work quickly and consistently throughout a document. If you want to
change the appearance of a style in the text, you simply modify the style properties and
reapply the style.
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Quick styles

Quick Styles are sets of styles created to work together. Although a Quick Style set
is likely to contain all the styles that you need to build a document, you may want to
add a brand-new style. You can also create extra styles, such as a new table or list
style. Use your selected document to practise selecting styles using the following
procedure:

1. Select the text that you want to create as a new style.

For example, perhaps you want the word 'business’ to always appear as bold and
red in your document,

2. On the Mini toolbar that appears above your selection, click Bold and Red to
format the text.

3. Right-click the selection, point to Styles and then click Save Selection as a New
Quick Style.
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;a_l Set Numbering Value... f builet-1-., % buliet-2 % bullet-2-., ¥ bullet-2-, Emphasis % Footerl THL

AaBbC AaBbC AaBbCc AaBbC AaBbCcl AaBbCcl a) AaBb(

Adjyst List indents...

= Decresse indent

3 increass indent TH3 T He_exam.., THS Heading1  Tinstructi.. % instructi, T letters

A Eont.. AaBbCecl AaBbC AaBbCcl * A3BOCel -+ AaBCel - AaBOC 2 A3BI

W Paragraph. online_ins... T online L. Strong Ttable bu.. Ttable bu.. Ttable bu.. 9table_ch.

IS Bullets »

=y a) AaBbCc AaBbCcDd 1. AaBbCc A4aBbCeDE AaBbCeDd AaBbCcDd AaBbCcl

= HNumbernng 4

:A sy = ftable_let... Tlable_list Ttable_nu.. table text Ttable_te.. ftable te.. T text

o] 33

8, Hyperink.. AaBbCcI AaBBCEL HaBBCCL AaBbCcl AaBbCcl AaBbCel AaBbCcl
Look Up > f text-in2 highlight  highlight-... ¥ No Spac... online_link online_only print_only
Synonyms L 4aBbCcl AaBbCcl AaBbCe :C1 AABBCC AaBbCcl

-
Sp Trangiste Subtle Em... Intense €. Quote  Intense Q.. SubtieRef.. IntenseR.. % ListPara...

Additional Act ’
e +AaBbC +aaBbC O Az AQAB AsBbcer AsBbeer 1. AaBbC

fbultet-1 T oul = jader G list_elem.. | T numbers
Save Selection as a New Quick Style

/ \a l: Create 3 new style based on

! formatting of the currently selected
Titte text and add it to the Quick Style
set currently in use. f

Ugdate numbe,
Save Selection a5 3 New Quick Style...
Setect Text with Similar Formatting
4 Qlear Formatting
4, Apply Styles..

4. Give the style a name (for example, ‘Business’) and then click OK. The Business
style that you created appears in the Quick Styles gallery, ready for you to use
whenever you want text to be bold and red.
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Change existing styles

Alternatively, you may want to change an existing style in your document. For
example, to change the attributes of the Heading 1 style, select text that has the
Heading 1 style applied. Have a try on your existing document using the following
steps:
1. Format the selected text with the new attributes that you want.
For example, you might decide that you want to change the size for the Heading A
style from 16 pt to 14 pt.
2. On the Home tab, in the Styles group, right-click the style that you want to change;
for example, Normal.

AaBbCcDc AaBbCcDe AaBbhC( AaBbCcl AaBl .
i Normal @ T No Spac... Headingl Heading2 Title =

Styles o

3. Click Update to Match Selection. All text with the style that you changed will
automatically change to match the new style that you defined.

If you changed the styles in a document and the styles are not updating the way you

expected, click the Styles dialogue box launcher, and then click the Style Inspector

button |44 to find out whether text was manually formatted instead of formatted by

using styles.

- J

Headers and footers

Headers and footers are displayed at the top and bottom of each page in
a document and usually contain information about the document.

They can include a single line of text, multiple lines of text, a table or graphics. Headers
and footers commonly contain information such as the document’s file path (or code),
date and page number.

Often, there is a workplace standard about the information that goes in headers
and footers. This ensures that all readers are aware of certain information about the
document, such as when it was written or where it is located on the server.

The header and footer information can be contained within a section of the document,
or can run through the entire document.
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Add a header and footer

You are now going to add a header and footer to your Word document.
Follow these steps:

1. On the Insert tab, in the Header & Footer group, click Header or Footer.

[ Header~

D Footer -

[#] Page Number~
Header & Footer

2. Click the header or footer design that you want and type in text or select a built-in one.

N /

~

Change a header and footer

You can insert or change text or graphics in headers and footers. For example, you
can add page numbers, the time and date, a company logo, the document title or file
name, or the author's name. To do this, follow these steps:

1. On the Insert tab, in the Header & Footer group, click Header.

[ Header~
D Footer ~
[#] Page Number~

Header & Footer

2. Click Edit Header. This takes you to the Header & Footer Tools tab.
3. Insert text or graphics.

4, To save the header that you created to the gallery of header options, select the text
or graphics in the header or footer, and then click Header as before. This time click
Save Selection to Header Gallery.

If you want to change a header that you inserted, find the Headers & Footer group in
the Insert tab, click Header as before, then select Edit Header.

You can also create a different first-page header and ) ]

footer or add different headers and footers on odd Different First Page

and even pages. To do this, click on the appropriate Different Odd & Even Pages
selection in the Options grouping under the Header
& Footer Tools tab.

To insert or change a footer, repeat these steps by
selecting the Footer option in each step.

N /
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Format tables

Tables are used to display information within a document.

A table is basically a grid of rectangles (or cells). Into these you can add text, numbers
and graphics.

You can customise a table to suit the needs of your workplace. They are often used
in business documents to present figures in rows and columns, or to show related
information side by side.

Some examples of customisation are listed below.

How to customise tables in business documents

* Adjust the width of columns or the height of rows.

 Insert text, numbers or graphics in a cell and align it to the left, centre or right.
 Fill a cell with a colour and/or a pattern.

» Format the cell borders by adjusting the line style and thickness.

Insert a table

Use the Insert tab and select Table.

You are now going to insert a table in your Word document and enter some

information. Follow these steps.

1. Move your cursor to the place in your document where you want to insert a table.
If this is at the top of a page, leave enough space above the table for a label.

2. Select a table choosing at least three columns and four rows.

3. Enter information into your table. When you enter information into a cell it will wrap
around to fit the width of the cell. The cell depth will expand to accommodate the
information. Make sure each column of your table has a heading.

Practise moving your cursor from one cell to another using the Tab key. To move your
cursor back to the previous cell, just click in the cell, or press Shift+Tab. To create a
tab within a table, use Control+Tab.

You should now have a table that contains information. It might look like the following

table.
S e T o e |
War and peace Leo Tolstoy $35.00
A tale of two cities Charles Dickens $40.00
Pride and prejudice Jane Austen $25.00
Little women Louisa May Alcott $30.00

N /
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Select parts of a table

Before you can do anything with the information in a table, you need to be able
to select the parts you want to format.

One way to do this is to use the Layout tab under Table Tools, and then choose Select.
This way you can select rows, columns and even the whole table with a single click of
the mouse.

Following are some simple steps you can follow to select a group of cells.

Select block of cells

1. Move your cursor into the first cell to be included in the selection.
2. Click and drag over the required number of cells.

Select a row

1. Move your cursor to the left edge of the first row to be included in the
selection.

2. Click and drag down the table to select the required number of rows.

1. Move your cursor onto the top edge of the first column to be included in the
selection. The cursor will change to look like a black arrow.

2. Click and drag across the table to select the required number of columns.

Select the whole table

1. Move your cursor to the top left-hand corner of the table. The cursor will
show a four-arrow symbol.

2. Click the symbol and all cells in the table will be selected.

J
|
|
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Using the
mouse option

Using the
menu option

Resize columns and rows

Depending on the type of information you have entered into your table, you may need
to resize columns and rows. There are two ways of resizing columns and rows. You
can simply use your mouse to drag the table parts into the right size, or you can use
the menu options.

You are now going to resize the columns and rows in your table. Follow these steps.

1,

1.

N

3. Select the Column tab. Enter the column width into the

~

Move your mouse onto the right edge of a column or the
bottom of a row you want to resize. Your cursor will change
into a two-headed arrow.

Click and drag the column or row to the required width or
height.

Select a column to resize.

Select the Layout tab under Table Tools. Click on Properties.

Preferred width box. You may have to experiment with the
correct size by looking at how the width change has altered
your column.,

Click on the Previous Column or Next Column buttons to
change the width of adjacent columns.

Select a row and repeat these actions to modify its size.

/

N

A tale of two cities

Pride and prejudice

Little women

~

Resize columns and rows

When you have finished, your table might look like the following example, where the
columns have been resized to suit the information and save space.

I T T

War and peace

Leo Tolstoy $35.00
Charles Dickens $40.00
Jane Austen $25.00
Louisa May Alcott $30.00
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Insert columns and rows

Business documents can alter as new information becomes available and old
information becomes out of date. You may have to add or delete information entered

into tables.

You are now going to insert a new row and column into your table. Follow these steps.

Insert a row Place your cursor in the last cell of a table and press Tab.
OR:

o s wop o

Insert a column 1.

3. Select the Layout tab and the Rows & Columns group.
4. Select either the Insert Left or Insert Right option.

Design the document | Topic 2

Decide where you want to put the new information.
Select a row that is above or below the required position.
Select the Layout tab and the Rows & Columns group.
Select either the Insert Above or the Insert Below option.
Enter the new information.

Decide where you would like to put the new information.

Select a column that is to the left or right of the required
position.

Enter the new information.

Delete columns and rows

You are now going to delete a row and a column from your table. Follow these steps.

Delete a row 1,

EalN S

Delete a column 1,

3. Select the Delete option.

Decide which row you want to delete and place the cursor
in that row.

Select the Layout tab and the Rows & Columns group.
Select the Delete option.

Select the Delete Rows option.

Decide which column you want to delete and place the
cursor in that column.

Select the Layout tab and the Rows & Columns group.

Select the Delete Columns option.

45



46

BSBTEC301 | Design and produce business documents

Insert columns and rows

When you are finished you should have a table with a new row and a new column
of information, like the following example.

e ——

War and peace Leo Tolstoy $35.00

A tale of two cities Charles Dickens $40.00 E24
Pride and prejudice Jane Austen $25.00 E25
Little women Louisa May Alcott $30.00 E26
Tender is the night F Scott Fitzgerald $25.00 E27

Insert or merge a cell

When working with tables, you may sometimes need to insert or merge a cell,
perhaps to create room for a title or a heading. You are now going to insert and merge
a cell in your table. Follow these steps.

Insert a cell 1. Select one cell in the first row of your table.

2. Select the Layout tab and the Rows & Columns group.
Click the small arrow and select Insert Cells menu option.

3. You should see the following dialogue box.

Insert ? X

Insert
O Shift cells right

) Entire row
(O Entire column

coc

4, Select Insert entire row. Click OK.

Merge a cell 1. Select your new row.

2. Select the Layout tab and the Merge group. Select Merge
Cells menu option.

3. You should now have a row with one merged cell. Enter the
title of your table into the new merged row.

N

/
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Insert or merge a cell

When you have finished, your table might look something like the one below.
This table has a title row created from a new merged cell.

Classic books

Title Author Price Code
War and peace Leo Tolstoy $35.00 E23
A tale of two cities Charles Dickens $40.00 E24
Pride and prejudice Jane Austen $25.00 E25
Little women Louisa May Alcott $30.00 E26
Tender is the night F Scott Fitzgerald $25.00 E27

Format table content
To format the content use the Font group under the Home tab. Refresh your memory
by re-reading this information.

You are now going to format the content of your table using the following
specifications:

* Title: Arial 14 pt, bold, centre align

e Column headings: Arial 12 pt, bold, left align

« Content: Arial 10 pt, left align

The end result might look like the following example.

Classic books
Title Author Price Code
War and peace Leo Tolstoy $35.00 E23
A tale of two cities Charles Dickens $40.00 E24
Pride and prejudice Jane Austen $25.00 E25
Little women Louisa May Alcott $30.00 E26
Tender is the night F Scott Fitzgerald $25.00 E27

/
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Add borders and shading

The appearance of a table can be enhanced by adding borders and shading.
Your organisation may have a preference for this type of formatting.

You are now going to apply a border and some shading to the title row of your table.
First, to apply a border, follow these steps:

1. Select your title row.
2. Select the Design tab.

3. Select Borders from the Draw Borders group.
“ ‘:l‘ U R LANGN PAGE LAYOUT REFERINCEY AR PGS Hvare Vaw caviLcet

4. Your title row should now have a border similar to this Classic Books example.

5. Next, to apply shading, follow the same steps as before but select Shading from
the Table Styles group.

Merge and compare documents, and track changes

Tracking changes, and merging and comparing documents are useful
techniques to help when multiple people work on documents.

Business documents are often written by a number of people. Multiple people can also be
involved in the edit.

To complete the work in this part of the topic, you need two identical documents. Make
two copies of the Word document you are currently working on, and call them Document
1 and Document 2.

The Track Changes function is very useful if you want to revise or edit a document.

It allows Microsoft Word to track the changes you make using revision marks to show
these. The changes — which can include insertions, deletions, moved text or graphics, and
formatting — can then be reviewed and accepted or rejected by someone else.

If you are going through this process in several copies of the same document (for
example, there are several people involved in the edit), you can merge the different copies
and capture all the tracked changes into one document when they have finished. This
will give you one final document to edit at the end.
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Track changes

You are now going to track the changes in your Word documents.
Follow these steps:
1. Open Document 1.

2. On the Review tab, in the Tracking group, click the Track Changes icon. Click the
Track Changes icon to turn Track Changes on or off,

E&‘ E@All Markup -
Z

Track B Show Markup ~
Changes - Reviewing Pane ~
Tracking =

3. Make the changes that you want by inserting, deleting, moving or formatting text
or graphics. You can also add comments. Word will track these changes as you
make them. Save the changes and close the document.

Merge documents

If you send a document for review to several reviewers, and each reviewer returns
the document, you can combine the documents two at a time until all the reviewer
changes have been incorporated into a single document.

1. Open Document 2, then on the Review tab, in the Compare group, click Compare.

2. Click Combine revisions from multiple authors.

€] Previous D

— . 2] Next .
Accept Reject Compare Elock Restrict
v v ¥ Authors - Editing
Changes

[——:Fl_—] Compare... | -
17| == Compare two versions of 3
document (legal blackling).

I:‘la Combine...
—=| Combine revisions from multiple

authors into a single document.

#13 14 15 16

J
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~

Merge documents continued...

3. Under Original document, click the name of the document into which you want to
combine the changes from multiple sources. If you do not see the document in the
list, click Browse for Original

4. Under Revised document, browse for the document that contains the changes by
one of the reviewers,

5. Click More.

6. Under Show changes, select the options for what you want to compare in the
documents,
By default, Microsoft Word shows changes to whole words. For example, if you
change the word cat to cats, the entire word cats will show as changed in the
document and not simply the character 's’.

7. Under Show changes in, click Original document.
8. Click OK.
9. Word will merge all the changes into the original document.

Word can store only one set of formatting changes at a time. Therefore, when you
merge multiple documents, you may be prompted to decide whether you want

to keep the formatting from the original document or use the formatting from the
edited document. If you do not need to track formatting changes, you can clear the
Formatting check box, which is a pull-down menu under Show Markup.

\_ /

Spellcheck and edit

Spelling and grammar mistakes can change meaning and or distract readers from the
work you have put into your documents, so you want to eliminate these mistakes. Word
can check the spelling as you type, or you can run a spellcheck separately to check the
text of an existing document.

As well as using this convenient tool, you must also do a manual proofread of every
document. Unfortunately, the Word spelling function can miss words that are not
appropriate even though they are spelled correctly.

Spellcheck as you type (AutoCorrect)

You can use the AutoCorrect feature to correct typos and misspelled words, as well

as to insert symbols and other pieces of text. The AutoCorrect feature can be a very
useful function. It means that Microsoft Word will automatically alert you to the words
you misspell. AutoCorrect is set up by default in Microsoft Word with a list of typical
misspellings and symbols but you can modify the list that AutoCorrect uses.
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AutoCorrect: English (Australia) ? X
AutoFormat Actions
AutoCorrect Math AutoCorrect AutoFormat As You Type

[¥] show AutoCorrect Options buttons
E Correct TWo INitial CApitals

Exceptions...

[ Capitalize first letter of sentences

[V capitalize first letter of table celis

E] Capitalize names of days

E] Correct accidental usage of cAPS LOCK key

E] Replace text as you type

Replace: With: Plain text Formatted text

cat [tetine]

|catagory | category A
| categiory category

|certian | certain
| challange | challenge
| challanges challenges
{chaneg change v

EI Automatically use suggestions from the spelling checker

oK Cancel

Beware of relying too heavily on AutoCorrect, particularly if you sometimes have to use
unusual words that might look like errors.

Spellcheck

You may prefer it if none of the documents you create show any spelling and grammar
errors.

1,

3. To turn on or off automatic spellchecking and automatic grammar checking for the

~

Click the File tab and then click Options.
Click Proofing.

currently opened document:
« Under Exceptions for, click on the name of the file that is open.

¢ Select or clear the Hide spelling errors in this document only and Hide
grammar errors in this document only check boxes.

To turn on or off automatic spellchecking and automatic grammar checking for all
documents that you create:

» Under Exceptions for, click All New Documents.

e Select or clear the Hide spelling errors in this document only and Hide
grammar errors in this document only check boxes.

If you turn off automatic spellchecking or automatic grammar checking for a file

that you share with other people, you may want to notify those people that you
made this change.

/
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Check grammar

Proofreading a document also means checking the grammar. Although you can do this
yourself, Microsoft Word provides a useful grammar check that you can use.

The grammar check identifies potential errors in punctuation and the use of verbs. It may
also identify any misused words or long sentences. It can check grammar as you type, or
you can run the grammar check after you have finished writing the document. It can also
be used to check the text of an existing document.

As well as using this convenient tool, you must also do a manual proofread of every
document. Unfortunately, the suggestions made by the grammar-checking function are
not always accurate, so you need to be careful about selecting changes.

Follow the same process for checking grammar as you did for checking spelling.

Practice Task 7

Question 1

1. This is your first chance to work on the Word document that you have found or created. Use
the following basic formatting functions to complete these tasks. You do not have to save
the changes in your document.

« Select three different fonts and three different font sizes. Apply these to part of your
document.

* Bold, italicise and underline some of the sentences in your document.

« Use the numbering function to list some of the sentences in your document.

¢ Add a border to one sentence in your document.

» Highlight one sentence in your document and change the font colour of another.

2. Find the Page Number Format dialogue box. Format the page numbers of your document
so that they are in lower-case Roman numerals; for example, i, ii, ii.

3. Use the table you have just inserted in your document to complete the following tasks:
e Select three cells in your table.
* Select two rows in your table.
¢ Select one column in your table.
¢ Select the whole table.
4, Resize some rows and columns.
5. Merge some cells.
6. Format the content in the table.
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Summary

People who produce business documents need to identify, open and create files
according to task and organisational requirements.

Staff need to create, update and store their files in suitable locations so that they
can be easily accessed and maintained.

A business document is formatted to improve the presentation and appearance of
information.

Designing and formatting a document is about organising the structure and style
to maximise the readability and understanding of the information.

A range of software functions can be used to design, format, edit, merge, check
and improve the presentation of a document.
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Learning Checkpoint 2
Design the document

Part A

1. Create a simple business document using Microsoft Word. Format the document and write
down the specifications of the formatting you choose.
Use the following formatting functions:

A style with a font and font size selection
Bold, italic and underline functions
Alignment function (at least once)
Numbering or bullets

Decrease or increase indent function
Border (outside)

Highlighting or font colour

Insertion of a graphic
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2. Imagine that you are training someone to use a keyboard. Design a cheat sheet or tips page with at
least five points for your student to learn. Explain how you are going to teach each point.
Part B

1.

Design a document for either your organisation or an organisation that you are familiar with.

If you are in the workplace, talk to a manager and decide on a business document that needs

to be designed. If you are learning in a classroom or at home, design an absenteeism report

for Happy Kids Primary School. The daily report should show which children are absent on

a particular day, how many days they have been absent, and whether there has been any

information from the parents about why the child is absent. It might also show which classes

the children are in.

a) Choose an appropriate software application to design your document and give a reason for
your choice.

b) Make sure that the document includes:
appropriate design principles
a range of formatting functions.
c) Describe how you used the principles and functions.

d) Asyou work, use the shortcuts on your keyboard and customise your mouse to whatever
suits you best. Describe how you did this.

e) Identify any other files or records you had to access to create this document. Explain where
they are stored and how you accessed them.

f)  Give the digital copy of your document a name. Explain how this meets the needs of your
organisation.
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2. Design a business document using the following content.
Dealing with stress
Take regular breaks
Exercise
Find someone to talk to
Reduce your tea and coffee intake
Every 20 minutes rest your eyes. Take a walk around the office. Try to go outside at
lunchtime. What are other ways to de-stress?
If you are sitting for long periods or working at your computer for extended periods, stretch
your fingers, arms, shoulders, neck and legs. Have a copy of exercises pinned up near your
workstation.
Talking to someone about how you feel helps you let off steam. A good laugh also helps
you to calm down and puts the reasons for your stress into perspective.
Tea and coffee are stimulants. Too much caffeine keeps you awake and hyperactive.
a) Use Microsoft Word to design your document,
b) The design of the document is up to you, but try to include a graphic. You must also include:
appropriate design principles
styles
table formatting
headers and footers.

c) Describe how you used design principles and the functions listed.

d) Asyou work, use the shortcuts on your keyboard and customise your mouse to whatever
suits you best.

e) ldentify any other files or records you had to access to create this document; for example,
files from your place of study or at home. Explain where they are stored and how you
accessed them.

f)  Give the digital copy of your document a name. Explain how this meets the needs of your
place of study or home.

Part C

Access and download employee-inquiry-sheet.docx at: aspirelr.link/employee-inquiry-sheet

Print off a copy of the document as it is, before you make any changes. Now, use the document
theme features to create a new document. Use the text from the form but apply either a predefined
or a custom document theme to change the appearance of the entire document. Change the
colours, fonts and any line and fill effects. Once you are happy your new form has a professional
and modern look, save it and print it.

Once you have done this, go back to your original form and go through this process again but using
a different theme. Also add some graphics. Save and print this new form.

Then submit both versions of the form (together with the original) as part of your assessment.
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3A
3B
3C
3D

Complete document production according to organisational requirements
Check documents for style and layout
Store and save documents

Overcome basic difficulties with document design and production
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3 A Complete document production according
to organisational requirements

Whenever you have to produce a document, you need to ensure it meets
organisational policies, procedures and requirements.

Every organisation has different requirements for business documents. Most important
is to present an appropriate and consistent corporate image by using the organisation’s
logo, colour scheme and style.

Make sure you know where these instructions are kept and that you are familiar
with them.

What is required or appropriate for one organisation may not suit another; for example, a
law firm’s requirements would be different from those of a sports equipment retailer.

Many organisations have established guidelines and procedures for production that you
must follow.

Established guidelines and production procedures may include:

« adhering to content restrictions
* using templates
+ following the organisation’s style guide

 including key details in the header and footer, such as the date, the organisation’'s name and
the document title

» observing copyright requirements
« delivering the content in the designated time line.

Time lines

One important factor of production guidelines is to ensure that project or task
time lines are met.

A time line is a plan for how long a task will take to complete. It also breaks the task into
steps and details when each step needs to be completed by. The time line needs to allow
enough time to design, edit and review the document. Your supervisor will often give you
a due date or deadline, and it will be your job to monitor and report on your progress.

You must also ensure that documents have a consistent style and image so that
customers, business associates and anyone receiving material from your organisation
will instantly recognise its brand.
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Clients and customers will form an opinion of an organisation based on the documents
they receive. In some instances, a document that looks unprofessional or contains errors
can be the difference between gaining and losing a client.

Many organisations have policies and procedures for staff to follow, including style
guides and templates for producing documents. In larger organisations and government
departments, style requirements are usually clearly defined, while smaller organisations
often have no formal documented style guide and staff are expected to follow examples
of documents previously produced.

Conforming to organisational requirements will ensure you are able to complete your
work in an efficiently and on time. It is very frustrating to have spent hours working on
the design of a document, only to find it does not meet requirements.

Presenting a consistent corporate image

A corporate image for documents can be compared to a staff uniform.

Many documents can wear this uniform, including correspondence, forms, emails,
memos, websites, invoices, statements and reports. Just like staff in a company, this
uniform may vary; for example, managers often wear a different company shirt or
uniform to other employees. Documents can also incorporate different parts of the
company’s image into their design.

A corporate image has several components, including:
« logo
+ colour scheme
+ house styles and templates.

Consistent use of the same colours, logos and designs ensures that documents are easily
recognised as belonging to your organisation.

Organisational style guides

Style guides are used to ensure consistency in the presentation and final look of
the documents produced by an organisation.

This may include using standard templates or using the corporate letterhead for certain
types of documents that have a similar style and format. Clarify the use of style guides
for your organisation with your supervisor and colleagues.

Style guides vary between organisations. They often provide information on the desired
writing style and specify the preferred formatting of text and pages with specific layouts
and designs of a variety of documents.
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Document layout and design may relate to:
+ margin width
. font type and size
. spacing of text and paragraphs
. alignment of text
« use of headers and footers and what information they must contain
. reference details, such as a list of sources referred to in a report
- signature blocks and document sign-off

+ use of company logos and slogans, and where they must be located.

Below are some styles relevant to writing style and formatting.
Writing style

» Use of abbreviations

» Preferred spelling of particular words
» Use of hyphens

e Use of capital letters

e Use of full stops

Text and page formatting

+ Font size and type

* Margins

* Indenting

+ Bullets and numbering
* Headers and footers

* Borders

The following is an example of some things that might be included in a style guide.
Dates

The date must be included in the upper right of the document in the following
format: Day Month Year.

Legislation

When referring to an Act of parliament, if the date follows the Act, the Act must be
written in italics. If there is no date, italics are not necessary; for example:

Copyright Act 1968 (Cth)
the Privacy Act
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Spelling and hyphenation

C

checklist
check-up
Commonwealth
coordinate
cost-efficient

Font

Arial 12 pt must be used for the body text of a standard letter.

Layout

The left margin must be indented at 4 cm.

Headers

File reference details must be provided at the top of each page in italics.

There may also be protocols for naming and saving files and folders in specific locations.

Templates

Templates are used to establish a consistent style and layout for particular
documents.

Templates define the preferred layout and text formatting for documents, ensuring
consistency in design. Most organisations have templates for letters, memos, minutes
and agendas. They may also have templates for reports, flyers and brochures.

The advantages of templates are shown here.
Consistency

Using templates ensures that information is always presented in the same

manner, making it easier for readers to locate important information. An example
of a common template is the layout of a monthly bank statement. Because the
information is always presented in the same format, the reader knows where to find
the various transaction details.
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Saved formatting

Templates can be as simple or as complicated as required, and may include pre-
formatted margins, fonts, columns, headers and footers, logos, colours and styles.

Template integrity

Because templates are used by various staff members, organisations must ensure
that no changes are accidentally made to them. For this reason templates should
be saved in a specific location as a special template file type. This ensures that
when you open a template document, you create a new document and the original
remains unchanged.

Templates are special files that are not stored with the rest of your documents. This is
so software such as Word ‘knows’ where to find them so they can be accessed when
creating a new document. You can see where your templates are being stored by
checking the default file locations.

To create a template, select the File tab and click New. Select Blank document and
create and format the template you require. Click File, Save As, then choose Browse. In
Word, in the Save as type box, select Word Template (*.dotx).

Content restrictions

There are some details you are not permitted to give out in written documents.

The kind of information subject to content restrictions depends on the organisation, and
may include results of investigations, financial data or employee details.

Content restrictions can also be applied to the way an organisation words its documents
to ensure information is not misinterpreted or acted on without professional advice
being sought. For example, a financial planning firm that recommends a particular
share purchase in its monthly bulletin may include a line that says: ‘Please consult your
financial adviser before acting on any of the information received in this bulletin’

When creating documents, check with your supervisor to ensure you are following your
organisation’s guidelines regarding restricted content.
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Copyright legislation

Copyright ensures that content, including text and images, is not copied from another
source without receiving permission from or acknowledging the copyright owner.

The Copyright Act 1968 (Cth) sets out copyright legal obligations in Australia. To avoid
breaching copyright law, always record the details of any images or text you intend to
use from another source and reference them appropriately only if you have been given
permission by the copyright holder (including the author and original source).

Details about appropriate referencing methods can generally be found in an
organisation’s style guide. Alternatively, ask a colleague or supervisor if you are unsure.

For more information on copyright, visit the Australian Copyright Council’'s website via:
http://aspirelr.link/australian-copyright-council

Practice Task 8

Imagine you work for JC Jackson Photography. You have been asked to create a flyer to promote
a special offer on reprints, which includes a free gift.

Question 1

If you were unsure of the requirements of the task, what would be two things you could do
to ensure you have all the information you need?
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Question 2

List three things that must be included in the document.

Question 3

Write three questions you would ask your supervisor to clarify the task requirements.
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Question 4

Give three examples of the types of information you may find in your organisation’s style guide.

Question 5

What is the main purpose of using a style guide?
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3 B Check documents for style and layout

Organisations have processes and specifications to ensure their documents meet a
certain standard of layout and style. Even though you may follow these requirements, you
may still make mistakes. Because of this, all documents must still be checked for errors.

Creating and using a checklist

A checklist is often used to help people systematically go through the points that
need to be considered before a document’s final draft.

Many organisations have their own checklists for proofreading and editing documents.
Using a checklist will help you edit and proofread quickly and efficiently. If your
organisation does not have a checklist, perhaps you could develop one for it to use.

Here are some things to consider when checking documents for style and layout.
Style

» Styles should be consistent.

» Make sure headers and footers are correct and spacing is consistent throughout; for
example, 10.30 am is always written in the same way.

» Check the in-house style manual.
» Are fonts, heading sizes, bold and italics used consistently and correctly?
» Consider using styles in your document to ensure and enforce consistency.

Layout

* Does your document layout meet the task requirements?

» Does your document conform to organisational requirements?

* Is your document the correct length?

» Have you allowed for enough white space to maximise readability?
» Do images and tables have accurate captions?

» Do images and tables appear in the correct place in the document?
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Look at the two documents below and outline what changes have been made to the document on

the left to produce the document on the right.

Packers Carpets and Mats Please put the

Customer Satisfaction Survey

on the front
counter.

completed survey
in the box provided

Please take a few minutes to complete the following customer service survey. We
appreciate your feedback

How would you rate our customer service?

Telephone:
12345678910
Poor Excellent
In person:
12345678910
Poor Excellent

What can we do to improve our customer service? Please give us some suggestions.

How would you rate the product knowledge of our staff?
12345678910
Poor Excellent

From which products do you think our staff could benefit from additional
product training?

When browsing in our store do you find it easy to locate products? Yes / No
If No, what difficulties do you have?

Were all our products priced clearly and correctly? Yes / No
If No, how often do you find items that are not priced or priced incorrectly?

Have you had any other problems shopping in our store? If so, please give a brief
description.

We appreciate you taking the time to complete this survey.

Packers Carpets and Mats

Customer Satisfaction Survey

Please take a few minutes to complete the following customer service survey.
‘We appreciate your feedback

QI. How would you rate our customer service?

Telephone:

1 2 3 4 5 6 7 8 9 10
Poor Excellent
In person:

1 2 3 4 5 6 7 8 9 10
Poor Excellent

Q2. What can we do to improve our customer service? Please give us some suggestions.

Q3. How would you rate the product knowledge of our staff?
1 2 3 4 5 6 7 8 9 10
Poor Excellent

Q4. From which products do you think our staff could benefit from additional product
training?

Q5. When browsing in our store do you find it easy to locate products? Yes / No
If No, what difficulties do you have?

Q6. Were all our products priced clearly and correctly? Yes / No
If No, how often do you find items that are not priced or priced incorrectly?

Q7. Have you had any other problems shopping in our store? If so, please give a brief
description.

‘We appreciate you taking the time to complete this survey.
Please put the completed survey in the box provided on the front counter.
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3 C Store and save documents

Information is a valuable asset to any organisation. How information is saved
and stored, as well as how it is protected, is central to its management.

Information contained in documents within an organisation is usually saved and stored
on a computer that is connected to a server, allowing access to multiple users. A server
is a computer that delivers information and software to other computers linked by a
network.

To enable everyone to log on to a server, the systems administrator issues each user with
a username. Each user must then create their own password. A username and password
give access to the information needed to complete workplace tasks. Different users will
have access to different information.

Data needs to be safeguarded against accidental or deliberate damage. Data loss is
usually caused by either human error or system failure.

\

Save a new Word document

When saving a document using Microsoft Office 2013 applications, there are different
options compared with what was available in previous versions.

When using Word, to correctly save your document to avoid loss of data: Click options
in the Save As dialogue box to save a file to a file name, format and location that you
specify. If you are saving a file that has not been saved before, the Save As dialogue
box appears automatically when you click Save.

The following are the buttons and other options in the Save As dialogue box.

» Save in: In the list, click a location where you want to save a file. Use the Save in
list to move up one or more levels in the folder structure.

* Previous foIder:@ As you move through the folder structure in the Files list, this
button allows you to go back to the previous folder that you viewed.

» Up one level: Click the folder title to the left in the current folder structure to
access the folder up one level.

» Delete: Press the delete button on your keyboard to delete the selected file or
folder.

» Create new folder: New folder | Click this button to create a new folder within
the current folder.

e Views: = ¥ Click the arrow next to this button to display file and folder view
options.

» File name: Type or select a file name for the file that you are saving.

N /
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4 N

Save a new Word document continued...

e Save as type: In the list, click the file format in which you want to save the file.
Most 2013 Microsoft Office system programs can save files in more than one
format, so you may need to select the format that you want.

» Page title: When you save a file as a web page (under Web Page), Page title
displays the title of the web page.

» Change title: When you save a file as a web page (under Web Page), click Change
title to display the Set Page Title dialogue box, where you can create or change
the title of the web page.

» Tools: Click Tools to display a list of tasks that you can perform. The tools that are
available vary depending on the program you are using.

» Save: After you determine the location, file name and format of the file that you are
saving, click Save to save the file.

[~ *

+ Libearses + Documents » Folder level

Fic pame | SETEITITNIERS)

Sove 2 type  Woed Docment (".doca)

Ve Fokders oy Conce

e Cancel: To go back to the file without saving it, click Cancel.
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Folder structures

Most organisations have structured folders. This allows staff to set up folders quickly and
easily. Many organisations also have shared directories. These are folders that have been
placed on a network for certain groups of people to access. By using shared directories
and naming standards, you can avoid losing or misfiling electronic documents. Work

is less likely to be duplicated and information can easily be exchanged. Using a shared
directory also means that documents on the same or related subject are located together.
This helps when you need to find or retrieve documents.

If your organisation has a shared directory, you need to decide whether a document
should be placed in the directory or stay on your own hard drive. This is because some
documents are for your use only and others need to be shared.

To set up a shared directory, you have to find the shared network drive. Then go to
the folder level. This is the first place to organise the directory. Folders have a tree-like
structure that branches from a parent directory to sub-folders in a hierarchical structure.

\

Directory hierarchy

Consider this example of a directory hierarchy.

SERVER (C Drive)
Group A
Group B
L Group C
Procedures
Personnel
Projects
Project A
Project B
Project C

ProjectC_fimelines.docx

ProjectC_researchl.docx

In this structure the server has three folders for three separate workgroups: Group A,
Group B and Group C. Group C has three major folders: Procedures, Personnel and
Projects. The Projects Folder has three folders: Project A, Project B and Project C. The
Project C folder has two documents: ProjectC_timelines.docx and ProjectC_researchl.
docx. The file path for retrieving a document starts at the server and ends when the
correct document is located. For example, to reach ProjectC_timelines.docx the file
path is: C:\GroupC\Projects\ProjectC\ProjectC_timelines.docx.

)
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Digital storage

Your organisation will have policies and procedures in place when it comes to storing
data. Most organisations prefer employees to store files on a server in their building
which is backed-up regularly or onto an internet server, often referred to as the cloud.
Unless you are without access to your server or the internet, it is good practice not to
save files onto the hard drive of your computer or digital device as failure of the hardware
could result in data loss.

Practice Task 10

Read the case study, then answer the questions that follow.

Case study

Sean works as an office administrator in a large organisation. His duties include filing electronic
copies of information and backing up the server at the end of the day. His organisation uses a
shared directory.

At the end of a busy day, Sean had to file a number of folders in different locations. He remembered
some of the locations but had to guess the correct location for a couple of reports. After this, he
was running late and decided not to back up the server.

The next morning, the reports Sean had filed were needed for an important board meeting.
However, during the night a virus had infected the server, destroying all the information.

Question 1

Sean did not file some of the folders in the correct place. What might be the consequence of this?
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Question 2

Sean did not back up information from the server. What were the consequences?

Question 3

Explain why organisations need procedures for storing and securing information.

Question 4

List four advantages of using a shared directory.
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3 D Overcome basic difficulties with document
design and production

You will often experience difficulties when designing or producing business
documents.

Nothing in life is trouble free. The business technology you are using might fail or the
software might crash. Whatever the problem, it helps to have a plan for dealing with the
unexpected. Some organisations may have a helpdesk set up to aid employees.

Use online help features

If you are working in a Microsoft Office application you can use the online help
feature.

The way you navigate the Help window is much the same way that you navigate the web
in a web browser, such as Windows Internet Explorer. However, the Help window has
extra features that a web browser lacks.

You can find help for Microsoft Office programs in more than one place. Help is installed
on your computer when an Office program is installed and you can get extra help content
from Microsoft Office Online. You can specify where you want to search for Help, and you
can restrict the scope of your search to online or offline or to a specific category within a
program.

To choose between offline and online topics, follow these steps.
Offline help

* In the main window of your Microsoft Office program, open Help.
» You can access Help by using a keyboard shortcut: press F1.

 If you are using Access, Excel, PowerPoint or Word, click Microsoft Office ‘program
name’ Help “ , where ‘program name’ is the name of the program you are in; for example,
Microsoft Office Word Help.

 If you are using InfoPath, Outlook, OneNote, Project, Publisher, SharePoint Designer,
Visio or Clip Organizer, click on the Help menu, then click Microsoft ‘program name’ Help,
where ‘program name' is the name of the program you are in; for example, Microsoft Office
InfoPath Help.
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Online help

e On the Connection Status menu, which is located in the top left corner next to ‘Word
Help' of the Help window, click either Word Help from Office.com or Word Help from
your computer.

* Now whenever you open a Help window from any Microsoft Office program, the Help
window displays content from the source you chose.

» Your system administrator can disable the ability of the Help window to go online.
* If this happens, the Show content from Office Online option is not displayed.
» For more information, contact your system administrator.

Read manuals

Most equipment and software come with a user manual that describes the
features and gives step-by-step instructions for use.

Manuals include information about functions, maintenance, use, work health and safety
issues related to the equipment or software, and troubleshooting tips.

Manuals can come printed (as a brochure, book or booklet) or in digital format; for

example, online.

There are many websites that have information about Microsoft Office applications.
These usually contain frequently asked questions (FAQs) and give solutions to common
problems. You can also download updates, tools and any fixes that Microsoft has
developed for its software problems.

You might find the following websites helpful.

Microsoft Office Microsoft Office Applications

http://support.microsoft.com http://office.microsoft.com
This is Microsoft's main site for finding help This site provides resources for all Office
with Microsoft Office programs. You can ask applications. It has news, announcements

questions online and download files including ~ and useful files for you to download.
service packs, drivers and patches. You can

also access the Microsoft Knowledge Base.

This is a good source of help for all problems

related to using Microsoft Office.
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Read training notes

There are many ways to learn about computer functions and software packages.

You can go to a training course to learn a particular computer function. Some suppliers
also provide instructions on how to use their equipment.

You may have received some training when you started your job, but it should not stop
there. It is important to keep up to date with technology. Try to locate the courses in your
area that offer software training. These courses usually provide a comprehensive set of
notes that are worth keeping for future reference.

Tips for overcoming difficulties:

* Access printed manuals and training booklets in your workplace.
» Find websites that offer advice on software functionality.
» Ask colleagues for help and advice.

Practice Task 11

Read the case study, then answer the questions that follow.

Case study

Audrey is a personal assistant to the manager of a large organisation. One of her duties is to
produce business documents using a variety of software applications. While producing documents
Audrey often needs to use the Microsoft Office Help to answer questions about software
functionality. If she is puzzled by anything on the screen, she presses F1 and types in her query.

If Audrey experiences software function problems that cannot be solved using the Help, she

uses Microsoft's support website to find solutions. There is also a printed manual available in her
workplace and she has copied the pages that she uses most often, keeping them in a Help folder
on her desk.

Question 1

Audrey sometimes has a software functionality problem. Where does she go for help?
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Question 2

When Audrey experiences a problem on the screen, what might she do other than use
Microsoft Help or Microsoft Support websites?

Summary

A time line sets the schedule for a task or project and gives details of each task
that needs to be accomplished to achieve that goal. To meet a due date you need
to first define the scope of the document, understand organisational requirements
and know who your audience is.

Organisations have processes and specifications to ensure that their documents
meet a certain standard of layout and style. Spelling, grammar and punctuation
need to be checked carefully when proofreading.

Data needs to be safeguarded against accidental or deliberate damage by
appropriate storage of documents and consistent saving and naming methods.

Online Help is a good place to access help and overcome difficulties.
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Learning Checkpoint 3
Produce the document

Part A

You have been asked to produce a business document by a certain date. To successfully meet this
requirement, you need to define the scope of the document.

1. What does ‘produce a business document by a certain date and define the scope of the
document’ mean?

2. How would you develop a time line to produce this document?

Part B

Read the case study, then complete the tasks that follow.

Case study

Office Temp is an organisation that supplies temporary office staff. It has four work groups, each
with two major areas of operations: Temporary Staff CVs and Client Information. Multiple files need
to be stored in folders representing each area of operation. All staff CV files must start with CV
and all client information files must start with Cl. The work groups have a shared directory on the

C drive.
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1. Design a hierarchical folder structure to suit Office Temp. Refer to the example in this topic if
you need help. Make sure you choose folder names that are consistent, simple and meaningful.

Part C

1. Produce a business document such as a newsletter or report. The topic is up to you, but you

must discuss it with your trainer before you start. To develop the document, make sure that you
do the following:

Scope the document to decide exactly what information it will contain.
Identify every task that must be done to produce the document.
Prepare a time line and allocate some time for every task.

Develop the document.

Proofread and edit the document for spelling, grammar and punctuation.
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2,

3.

Store the document in an appropriate way. Explain how you have done this.

Describe any difficulties you had when producing this document and explain how they were
overcome.



Topic 4 | Finalise the document

4A
4B
4C
4D

Proofread the document prior to final output

Make modifications

Name and store the document, and exit the application
Present the document

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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4A Proofread the document prior to final output

Proofreading means ensuring your final text is free of mistakes.

Using the spellchecking function alone is not sufficient; it does not pick up the incorrect
use of words, and cannot identify situations where you have typed a word that is
pronounced the same way as the word you wanted but means something different

(a homonym).

Make sure you allow time for editing and proofreading documents before they are
printed, published or distributed to colleagues. You may need to complete a final check of
the style and layout specifications and look out for spelling and grammatical errors.

Many organisations have a checklist to help people systematically go through the points
that need to be considered before a document is finalised. Your organisation may have
some special requirements that need to be checked as part of the editing process, so
make sure you are familiar with these.

Below are some aspects to keep in mind when editing and proofreading documents.
Document type

Ensure you have selected the correct type of document. For example, when asked to
collect some information, do the results need to be presented in a report or can they
go into a memo?

Audience, purpose and contents

Is the document you have produced suitable for the audience and purpose? Does
it need to be formal or informal? Is the language appropriate? Is there too much
jargon? Is all the required information included? Is it presented in an easy-to-
understand format?

Spelling, grammar and punctuation

Be aware that an electronic spelling and grammar checker will not always pick up
words that are used inappropriately (such as using ‘there’ instead of ‘their’), so it is
better to also proofread your document. Words may also be spelt in different ways;
for example, American and Australian spelling for words such as organize/organise.
Check the in-house style manual. You will need to use your discretion to decide
whether the suggested option is the best (or even correct!) one.



Finalise the document | Topic 4

Style

Ensure you have used the correct template, if one is available. Have you followed
the guidelines in the organisation’s in-house style manual, including use of logos
and fonts? Is the style consistent? Make sure headers and footers are correct and
spacing is consistent throughout. Check the in-house style manual.

Numerical and statistical data

Match your document with the original figures you were given, and check that all
data and calculations are accurate. It is very easy to make a mistake when entering
a lot of numerical data into a document.

Types of proofreading

There are three types of proofreading, as outlined here.
Comparison

A comparison proofread may not be applicable to every task. It applies to tasks
where you have an original document you are copying from. This could be your own
handwritten notes or printed notes with changes highlighted on them. A comparison
proofread requires a word-for-word, character-for-character comparison of the new
document and the old document. This is to ensure that the exact same words and
punctuation are in both documents.

Content

A content proofread focuses on the new document. The purpose is to look for
correct sentence structure, logic, spelling, punctuation, consistency and factuality.
The purpose of the content read is to make sure the document is correct and reads
well; that is, readability. Readability refers to how well the document flows; for
example, whether there are enough new paragraphs to separate different parts of
the content. A good trick to check a document's readability is to read it out loud

to yourself or to someone else. Take time to read through it several times. Another
strategy is to have someone else read it and give you feedback. Another person will
be in a better position to evaluate whether your sentences make sense.
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Format

A format proofread is the final proofreading. You are looking for a correct and
consistent format in the document. There are certain formatting conventions that
are often followed when preparing business documents such as a business letter.
A good starting point for a format proofread is to scan the edges of the document
and look for anything that is out of alignment. Then look at the overall page, and
check whether it looks balanced. For example, is the space between paragraphs
consistent? Are all paragraphs aligned to the left and right margins? Check page

numbers, headers and footers, if applicable.

Allow yourself a reasonable amount of time to work through each of these proofreading
stages to produce the most professional outcome.

When you are proofreading a business document you might like to consider the following
tips to assist you and make it easier when proofreading documents at future times.

Proofreading tips

Tips and tricks for proofreading:

Consider printing a copy of the document;
you may find it easier to detect errors on a
page than on screen.

Read it slowly; one word at a time,
covering the later words so that you do
not look ahead or look for meaning.

Have someone else read it.
Read it out loud and silently.

Read it backwards, in segments, so
aspects other than meaning, such as
spelling errors and layout, stand out more.

Use the spelling and grammar checking
functions at first proofing - but do not
depend on them entirely.

Double-check any numbers.

Allow time between completing the final
copy and proofreading; then look at it with
fresh eyes.

Proofread when you are most alert.

Do not try to proofread all types of
mistakes at once. During each read-
through, focus on different aspects.

Avoid distractions.

Watch out for homonyms. These are
words that share the same spelling
or pronunciation but have different
meanings.

Watch out for contractions and
apostrophes.

Make a note of your most common errors
so you can pick them up faster next time,
possibly by using the find and replace
function.
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Practice Task 12

Edit and proofread this business document. Consider its readability, accuracy and consistency of
language, style and layout. Reproduce the document, proofread it using appropriate techniques,

and print it. Make a note of the changes you have made as this may help when proofreading and
editing documents in the future.

Using software functions

You are now going to learn how to prepare an electric presentation. You will need to have
excess to a computer and Microsoft PowerPoint. The operating system used in this unit is
Microsoft Vista and the software is PowerPoint 2013. To design your present you need to
develop an understanding of the software functions and features of PowerPoint (i.e. what the
program allows you to do.) This will enable you to prepare a present that has a consistent style
and a visual impact.

In this part of the unit you will:
 create a slide show

» apply a design template

e add content

* right or draw on slides

» apply a style

« create handouts and speaker notes.

PowerPoint uses slides to build an electronic presentation. A slide is a single frame in a
presentation and a presentation comprises a group of slides. Before you start to design your
presentation, it will be helpful to become familiar with the names of sum of the PowerPoint
functions. Look at the functions and descriptions in the following table.

T

Placeholders Boxes with dotted lines that appear when you create a knew slide.

Slide Master Allows you to change the style of text and have the style reflected
throughout the hole presentation

Notes Master Allows you to create notes when working on your presentation.

Importing other  Allows you to import information from other applications such as Word
applications or Excel, and add them too your presentation.

Handout Master ~ Allows you to create handouts to go with you're presentation.
Colour schemes Is a selection of background colours that you can apply too your presentation.

Templates Templates contain colour schemes and text formatting to design
a presentation with a particular look.
Planning your presentation

As previously discussed, you need to plan your presentation before you begin. This means
working out:

» what the presentation is about (the purpose)
» how the presentation is for (the audience)
* how you are going to present the information? (the method).

Then you need to prepare the content of your presentation. The best way to do this is to create
a storyboard to help you map out the information you are going too present.
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4 B Make modifications

Once you have proofread the document and identified errors or inconsistencies,
you will need to modify (or edit) it.

The modifications you make will depend on what computer software you are using, what
sort of business document it is and what kind of modification.

You have already learnt about the edit feature of tracking changes in Microsoft Word, as
well as making design and layout modifications to text and tables. Another common way
of making modifications to an existing document is to scan it and then modity it.

Types of modifications

» Spelling and grammar
« Style

e Layout

e Theme

e Graphics

e Table layout

* Table formatting

* Headers and footers

~

Enable editing for a document that is marked as final

You may need to modify a document that has been marked as final at a previous time,
and therefore is only accessible in read-only format.

In Microsoft Office programs, documents in read-only format have a yellow MARKED
AS FINAL banner at the top of the document to discourage editing. But you can
override the read-only format by selecting the Edit anyway button.

N /
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Enable editing for a document that is marked as final

continued...
Set the Mark as Final command for a document that has been finalised as follows.
1. Open the document that has been approved as final.

2. Click the File tab, select Info and then click on Protect Document to select Mark
as Final.

Calendar - to check Mark As Final
Deshicp
Protect Document
b ’ U This document has been marked as fimal to discourage editing.
Protect
Document +

Ty Mark s finad
[+]

A Letreaders bnow the document o
(el and maks 4 read-enly
e that it containg
sate mame, author's name and relsted dates
sabilities might find dificult to read
y Restrict fgiting
narol the types of changes chess
can make
y Eestrict Accem o of this fie,
Q@ Grant propie sccers while rmtnang ’

their abuity 1o 38 Copy, of paint

Add 2 Digital Sigmature
R tasure the ategrity of the document
by adding an ivasibile digital Lgnaty

N /

Find and replace function

Another useful modification feature of Microsoft Office programs is the Find and Replace
option. This allows you to find and replace text, formatting, paragraph marks, page breaks
and other items. You can also find and replace noun or adjective forms or verb tenses. Be
careful when using the Replace All feature that you do not create problems such as incorrect
case. Unless you are able to narrow down your search criterion, it may be better practice to
replace one word at a time rather than replace all.

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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Find text

You can quickly search for every occurrence of a specific word or phrase.

1. On the Home tab, in the Editing group, click and select Find; or use the shortcut
Ctrl+F.
2. In the Search Document box, type the text that you want to search for.
All instances of the word or phrase will be highlighted in the document.
For more search options or to turn off the highlighting, in the Home tab click on the
Find drop-down arrow and select Advance Find...
@ Find ~
#% Find

@ Advanced Find...
=2 GoTo..

N

Find and replace text
You can automatically replace a word or phrase with another; for example, you can
replace Acme with Apex.

The replacement text will default to using the same capitalisation as the text that
it replaces. For example, if you search for AKA and replace it with Also known as,
the result will be ALSO KNOWN AS. You can override this by clicking More>> and
selecting Match case from the list of options.

1. On the Home tab, in the Editing group, click Replace (or Ctrl+H).

i Find ~

2 Replace

[% Select~

Editing

2. Click the Replace tab.
3. Inthe Find what box, type the text that you want to search for.
4, In the Replace with box, type the replacement text.
5. Do one of the following:

« To find the next occurrence of the text, click Find Next.

« To replace an occurrence of the text, click Replace. After you click Replace, it
will move to the next occurrence of the text.

» To replace all occurrences of the text, click Replace All.

N
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Find and replace specific formatting

You can search for and replace or remove character formatting. For example, you can
search for a specific word or phrase and change the font colour, or you can search for
specific formatting such as bold and change it.

1. On the Home tab, in the Editing group, click Replace (Ctrl+H).
# Find ~

25¢ Replace
[* Select~
Editing

To search for text with specific formatting, type the text in the Find what box. To find
formatting only, leave the box blank.

2. Click Format (under More), and then select the formats that you want to find and
replace.

3. Click the Replace with box, click Format and then select the replacement formats.

If you also want to replace the text, type the replacement text in the Replace with
field.

4. To find and replace each instance of the specified formatting individually, click Find
Next and then click Replace. To replace all instances of the specified formatting,
click Replace All.

~

/

Find and replace paragraph marks, page breaks and
other items

You can search for and replace special characters and document elements such as
tabs and manual page breaks. For example, you can find all double paragraph marks
and replace them with single paragraph marks.

1. On the Home tab, in the Editing group, click on the Find drop-down menu.
2. Select Advanced Find.

3. Click More, then Special and then click the item that you want.

~
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Make modifications in Microsoft Excel

Below is a common modification made when using Microsoft Excel. It is used to edit the
contents of a cell. This can be done either directly in the cell or in the formula bar.

1. To place the contents of a cell in editing mode, click the cell that contains the data
that you want to edit, and then click anywhere in the formula bar. This positions the
insertion point in the cell or formula bar. To move the insertion point to the end of
the cell contents, click the cell and press F2.

2. To edit the cell contents, do any one of the following:

« To delete characters, click to the end of where you want to delete them and then
press Backspace, or select them and then press Delete.

« Toinsert characters, click where you want to insert them, and then type the new
characters.

+ To replace specific characters, select them and then type the new characters.

« To turn on Overtype mode so that existing characters are replaced by new
characters while you type, press Insert.

+  Overtype mode can be turned on or off only when you are in editing mode. When
Overtype mode is turned on, the character to the right of the insertion point is
highlighted in the formula bar, and it will be overwritten when you type.

« To start a new line of text at a specific point in a cell, click where you want to
break the line, and then press Alt+Enter.

3. To enter your changes, press Enter. Before you press Enter, you can cancel any
changes that you made by pressing Esc. After you press Enter, you can cancel any
changes that you made by clicking Undo “>" on the Quick Access Toolbar (or
Ctrl+Z7).

Practice Task 13

Select a document of your choice and practise using the find and replace functions described in
this section. Also try marking your document as final and then allowing it to be edited.
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4C Name and store the document, and exit
the application

Appropriate naming conventions help in the identification and retrieval
of documents.

As well as placing folders and files in the appropriate places, you also need to give them
appropriate names. Naming methods should be kept consistent, simple and meaningful.

Your organisation may already have guidelines for naming files that you should use as
well as requirements for backing up data.

File Explorer is a file management application designed to manage files, folders and
drives. This, combined with the application program you are using, enables you to
manage files efficiently and logically.

Use meaningful file names

When using Microsoft programs and File Explorer, file names are listed alphabetically
based on the first word. Therefore, this first word has to be meaningful. For example, if
you have a folder of pro forma documents (such as memo forms, business letters, order
forms and letterheads), it would be logical to name them this way, rather than by Pro
forma memo and Pro forma letterhead as then they would all begin with the letter P..

Alternatively, in a letter folder you may use numbers as file names. For example, if you
write several letters to the one client you may name them Letter 1 Jack Smith, Letter 2
Jack Smith followed by the date. Numbering files is very common for organisations such
as insurance companies, who may name the document according to a policy number.

If you are preparing documents for regular meetings, you may like to label them with the
date or number of the meeting. Some people use a standard date format; for example,
20180401BoardAgenda (for a document dated 1 April 2018) or, particularly for monthly
meetings, simply use the year and month; for example, 2018-04BoardAgenda. It is better
to use the number rather than the name of the month, if you want the documents to
appear sequentially in your list of files.

Whenever you have a series of related files, it is a good idea to use the same or similar
file names for each file. Make sure that you can easily distinguish them from one
another, though!
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Save documents to avoid loss of data

After creating or modifying an electronic document, you need to save it to ensure that
your data is not lost when you exit the software application.

Some software applications are set up to auto save your file as you work on it. However, it
is good practice to always ensure you save your file before you close it or before you leave
your desk.

You would have already named your document when you created it. However, you may
need to make a copy or move it to a final folder. Your organisation will have guidelines on
where files should be saved so they can be found and protected against loss.

Ensure that you know where the file should be saved and if you must keep a copy of it.

Exit applications safely

When exiting an application, you need to ensure that you understand the method of
saving before exiting that is applicable to the program you are using,

Always save before exiting and ensure that all windows that are open in the program are
closed correctly before closing the program. Never shut down your computer until all
opened applications have been closed properly.

You can exit Microsoft Office programs either by selecting the File tab and choosing
Exit, or by clicking on the close button X at the top right-hand corner of the window.

Practice Task 14

Read the case study, then answer the questions that follow.

Case study

Datu has retired from an organisation after working there as an administrative assistant for 10
years. He had been responsible for two areas: Accounts and Projects. The day after he retired,
somebody urgently needed a file that Datu had created and stored. The file contained vital
accounting information. It was discovered that Datu had saved more than 500 files in a variety of
folders and the file could not be located. The folders had names such as Folder1 and Folder2 and
the files had names such as augustl.docx and march2.docx.
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Question 1

Describe why Datu's folder and file naming system failed.

Question 2

Datu was responsible for two areas. What folder names could he have used to make sure that
files were placed in the correct folder?

Question 3

Describe the consequences of placing folders and files with unclear names on shared
directories.
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4 D Present the document

Once you have done a final proofread of your document for spelling, grammar,
consistency and style, you are ready to print or send it.

The information you print may be for your own use or for someone else in the
organisation. If you are printing materials for someone else, make sure that you discuss
what they need before printing, as alterations may be required.

Also be aware of organisation requirements for printing and presenting documents. An
organisation may have a policy that business documents must be printed double-sided
(that is, using both sides of the paper) or that certain documents are printed with a
glossy, coloured front page and remaining pages are black and white. Familiarise yourself
with your organisation’s requirements.

If your document has been prepared using PowerPoint you can print out handouts,
speaker notes, outlines or transparencies. If your document is a Publisher or Word
document you will likely be printing the completed document onto paper, card or
transparencies and may also print envelopes.

Print from Microsoft Word

To print a Microsoft Word document, click File tab and select Print from the menu on
the left (or Ctrl+P).

You may need to use the following options in the Print options.

Print icon Click here when you are ready to print, after checking that Printer,
Settings and number of copies are correct.

Copies Click the arrows to increase or decrease the number of copies that
you want printed. You can also type the number in the box.

Printer Select your printer from the drop-down list.

Print to File This option is at the bottom of the Printer drop-down menu. Select
this to create a file from the document instead of routing it directly
to a printer. The file is saved with print formatting, such as font
selection and colour specification in a .prn file that can be printed to
another printer.

Printer Properties This link will bring up the Printer Properties dialogue box.

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting



Finalise the document | Topic 4

Settings

Print All Pages

Pages
Print One Sided

Collated

Orientation

Paper Size

Margins

Pages Per Sheet

Page Setup

You can choose to print the entire document, the current page or
specific pages. You can also choose to print only odd or even pages.

If Print Markup is checked, then all the tracked changes made to the
document will be printed on the right-hand side of the page. You

can also choose to print other document information such as a list of
styles used or the file name, author and title.

Enter the page range you wish to print.

Select if you want to print on one side, print on two sides or
manually load the printer to print on two sides.

If you collate the printing and print three copies of a document, you
will print pages 1,2,3,1,2,3,1,2,3 and so on. If you choose uncollated,
you will print pages 1,1,1,2,2,2,3,3,3 and so on.

Select either Portrait Orientation or Landscape Orientation.
Select the paper size you will be printing on.

You can select from a range of margin pre-sets such as normal,
narrow, moderate, wide, mirrored and Office 2013 default. You can
also click on Custom Margins, which will take you to the Page Setup
dialogue box.

Click the number of pages you want to appear on one printed page.
You can also choose to Scale to Paper Size.

Click this link to launch the Page Setup dialogue box for more page
setup options.

Print from Microsoft Excel

If you are printing from Excel, you will be printing worksheets or workbooks. You may

wish to preview your worksheets before printing to ensure the layout is satisfactory; for

example, to make sure that the worksheet fits on one page. Follow these steps:

1. Click the worksheet that you want to preview before you print it.

2. Click File tab and select Print from the menu on the left.

3. 'The Print preview will automatically be shown on the right-hand side.
Keyboard shortcut - You can also press Ctrl+F2 or Ctrl+P.

4. To preview the next and previous page, scroll up or down.

5. To view page margins, click on the Show Margins button & under Settings.

This displays the margins in the Print preview. To make changes to the margins, you

can drag the margins to the height and width that you want. You can also change the

column widths by dragging handles at the top of print preview page.
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To make page setup changes, use the drop-down menus under Settings. You can also
click on the Page Setup link to launch the Page Setup dialogue box and then select from
the options on the Page, Margins, Header/Footer or Sheet tabs.

Print handouts in Microsoft PowerPoint

In PowerPoint you can print your slides as handouts for the audience. You can also
choose how many slides you would like on each handout. The following method will print
out an exact replica of your presentation slides.

Follow these steps:
1. Open the presentation for which you want to print handouts.
2. Select the File tab, then click Print (Ctrl+P).

3. Click on Full Page Slides. This will bring up a drop-down menu where you can select
the handout option you want from the list.
The Handouts (3 Slides Per Page) format in PowerPoint provides lines for the
audience to take notes.
You can choose to print handouts in colour, grayscale or black and white. From
the main Print page, the last drop-down menu under Settings lets you make this
selection.

4. To change the page orientation, click the Portrait Orientation drop-down menu,
and select Landscape.

5. Click Print.

Printing tips

Many devices and programs are needed to perform a print operation and
sometimes these don’t work as they should.

Before printing your document, make sure that it has been saved securely. Also make
sure that the printer is properly connected and ready to receive print jobs. Replace toner
according to the supplier’s instructions and use the correct paper.

If you are printing onto preprinted paper, such as letterhead or certificates, make sure it
is inserted the correct way so as to avoid wastage. Also remember to remove any spare
preprinted sheets so that the next user does not waste these.
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The final presentation of your document will be determined by the type, size and
style of your document and the requirements applicable to your organisation or

client.

No matter which form of final presentation is used, the most important thing is that it
is clear, accurate, consistent in style and professionally presented. Following are some of

the various ways that business documents can be presented.

e Electronic presentation using PowerPoint .
or any program using the display provided .
by a data projector

* Presentation using transparencies and an
overhead projector

 Electronic presentation via email or
website

Practice Task 15

Question 1

Printed, collated and stapled documents
Bound book presentations
Printed documents in a display folder

Printed documents in a presentation
wallet displaying information unigue to the
organisation such as logo, letterhead and
organisation details

Printed and laminated documents

Printed reports in a ring binder or
clipboard

Describe the appropriate methods of presentation to present a yearly financial statement.

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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Question 2

How do you select to print only four consecutive pages in a 10-page document?

Question 3

If you are printing a four-page Word document, how do you print all four pages onto the one
sheet of paper?
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Summary

Before the final production of your document, you need to carefully proofread it
for readability, accuracy and consistency of language, style and layout.

There are many useful and practical tips to assist you in proofreading,

Once identified, the errors or inconsistencies in the proofread document need to
be assessed and modified as appropriate. The changes you make will depend on
your computer software, and the type of business document and modification
being considered.

Folders and files need to be given meaningful names to make sure they can be
easily accessed in the future. Naming methods need to be kept consistent. Your
organisation may have existing conventions for naming and storing documents.
The software application needs to be exited systematically to avoid damage or
loss of data. Damage or loss can occur if the document has not been correctly
saved or there is a system failure. However, the main cause of data loss is human
error. Backup procedures need to be followed methodically.

Business documents may be printed onto paper and presented in a variety

of different ways such as booklets or laminated documents. Alternatively,
documents may be presented electronically; for example, in an email or via a data
projector screen.

No matter which form of final presentation is used, the critical aspect is that
the information in the document is clear, accurate, consistent in style and
professionally presented.
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Learning Checkpoint 4
Finalise the document

Part A

1. Explain what methods you use in your organisation for printing and presenting business
documents. Provide samples if available and appropriate.

Part B

Using a software application of your choice, prepare a document that lists tips for best-practice
proofreading. You can refer to websites or other reference material. Your document should be in
a format that is readable, accurate and displays consistency of language, style and layout. When
complete, have someone review your document, make modifications and name and store this
document appropriately - according to organisational requirements.
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